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Введение 
Программа TDLCONF содержит набор инструментов для настройки и устранения 
неисправностей цифровых радиостанций и модемов семейства TDL, 
произведённых компанией Trimble. Эта программа поставляется вместе со 
всеми радиомодемами семейства TDL и её можно бесплатно загрузить с веб-
сайта компании Trimble ( www.trimble.com ). Запуск программы TDLCONF при 
подключенной с помощью последовательного интерфейса радиостанции 
семейства TDL позволит вам проверить состояние приемника, задать таблицу 
каналов, установить ширину радиоканала и выходную мощность. 

Техническая поддержка 

Если у вас возникла проблема и Вы не можете найти необходимую вам 
информацию в технической документации к устройству, обратитесь к местному 
дистрибьютору или технической поддержке на сайте Trimble 
(www.trimble.com/global-services). Для загрузки доступны обновления и 
техническая документация. 
Если вам нужно связаться с технической поддержкой, направьте письмо на 
адрес электронной почты support@Trimble.com. 

Ваши отзывы 

Мы производим регулярное изменение технической документации с учётом 
Ваших отзывов. Мы ждем ваших замечаний на readerfeedback@trimble.com. 
  

http://www.trimble.com/
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Установка программы 

1. Загрузите последнюю версию программы TDLCONF с адреса 
www.trimble.com/support, сохранив ее в папку на своем персональном 
компьютере (ПК). 
2. Извлеките содержимое zip-архива. 
3. Некоторые брэндмауэры запрещают загрузку исполняемых файлов, поэтому 
установочный файл программы называется TDLCONF_setup.xxx. Щёлкните по 
файлу правой кнопкой мыши, в появившемся контекстном меню выберите пункт 
Переименовать и замените "xxx" на "exe". 
4. Дважды щелкните по установочному файлу для начала установки программы. 

Запуск программы 

Запуск программы производится одним из описанных ниже способов: 

 Выполните двойной щелчок по иконке TDLCONF на рабочем столе. 

 Выберите пункт меню Пуск > Все программы > Trimble > TDLCONF > 
TDLCONF 

 Выберите пункт меню Пуск > Выполнить. В появившемся окне введите 
C:\Program Files\Trimble\TDLCONF\TDLCONF и нажмите ОК. 

Если у вас появились затруднения при запуске TDLCONF под Windows 7 или 
Windows Vista, проделайте следующие операции: 
1. Закройте программу. 
2. Запустите Windows Explorer или дважды щелкните по пиктограмме Мой 
Компьютер. 
3. Перейдите в папку C:/Program Files/Trimble/TDLCONF/ и вызовите меню 
щелчком правой кнопки мыши по файлу TDLCONF.exe. 
4. Выберите Свойства. 
5. Во вкладке Совместимость выберите Запустить программу в режиме 
совместимости с. 
6. Выберите Windows XP, Vista 32 или Windows 7 и щелкните ОК. 
7. Повторно запустите программу TDLCONF. 
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Пункты меню программы TDLCONF 
Основное окно программы TDLCONF содержит меню, состоящее из трёх 
пунктов: 
File (Файл), Edit (Правка) и Help (Справка). 

File (Файл) 

 
 

Выбор...  Позволяет... 

Upgrade 
Modem 
Firmware 
(Обновление 
ПО модема) 

выбрать файл встроенного программного обеспечения (ПО) в 
формате *.bin, который будет загружен в подключенный TDL 
радиомодем. Trimble рекомендует сохранять текущие настройки 
радиостанции перед установкой нового ПО. Используйте для 
этого описанную ниже функцию Export. Перед обновлением ПО 
программа предложит подключиться или переподключиться к 
радиостанции. См. раздел Подключение к радиостанции на стр. 
12. 
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Import 
(Импорт) 

импортировать конфигурационный файл (*.dat) радиостанции с 
Вашего компьютера в программу TDLCONF. Выберите Program, 
чтобы загрузить конфигурацию в подключенный прибор, текущая 
конфигурация при этом будет утеряна. 

Export 
(Экспорт) 

сохранить конфигурационный файл (*.dat) радиостанции на Ваш 
компьютер. Эта функция позволяет создать одну конфигурацию 
и запрограммировать её в несколько радиостанций. 
Примечание: при экпорте конфигурации создаётся файл с 
расширением (*.dat). Для последующей настройки 
радиостанции Вам надо открыть его с помощью программы, а 
затем воспользоваться кнопкой Program. 

View Report 
(Просмотр 
отчёта) 

отобразить в веб-браузере все параметры подключенной 
радиостанции. Кроме того, этот отчет (в формате HTML) 
показывает настройки ПО, которые 
могут помочь специалистам Trimble в обнаружении возможных 
проблем. 

Save Report 
(Сохранить 
отчёт) 

сохранить копию списка значений параметров в текстовом 
формате в выбранный Вами файл на жестком диске. 

Exit (Выход) выйти из программы. 
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Edit (Правка) 

 
 

Выбор...  Позволяет... 

Restore 
Factory 
Defaults 
(Вернуть 
настройки по 
умолчанию) 

показать фабричные настройки радиостанции. Разные типы 
изделий семейства TDL используют разные настройки по 
умолчанию. Какие бы изменения конфигурации вы не проводили, 
в памяти радиостанции сохраняются и настройки по умолчанию. 
Для просмотра выберите пункт меню Edit > Restore Factory 
Settings или воспользуйтесь кнопкой Restore Factory (Вернуть 
настройки по умолчанию). 
Программа TDLCONF сначала должна 
подключиться/переподключиться к радиостанции. См. раздел 
Подключение к радиостанции, стр. 12. 
Если программа TDLCONF уже отображает конфигурацию 
радиостанции, то появится следующее окно предупреждения: 
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Выберите Yes (Да) для того, чтобы скопировать настройки по 
умолчанию из радиостанции для их просмотра и изменения. При 
этом никаких изменений в параметры радиостанции внесено не 
будет до использования кнопки Program. или диалогового окна 
Exit (Выход). При возвращении настроек по умолчанию текущая 
таблица каналов в программе TDLCONF не изменяется. 

Undo All 
Changes 
(Отменить 
все 
изменения) 

отменить все изменения настроек, сделанные Вами в текущем 
сеансе. Настройки всех окон TDLCONF будут возвращены к 
состоянию, в котором они были в начале этого сеанса. Выбор 
этой кнопки не повлияет на настройки радиостанции или на 
какой бы то ни было конфигурационный файл на Вашем 
компьютере. Для того, чтобы изменить настройки радиостанции, 
Вы должны произвести изменения параметров и 
воспользоваться кнопкой Program. 
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Help (Справка) 

 
 

Выбор...  Позволяет... 

User Guide 
(Руководство 
пользователя) 

показать копию руководства пользователя TDLCONF (этот 
документ). 

Support 
(Техподдержка) 

получить доступ к ссылкам на техническую поддержку 
компании Trimble  и к основному сайту Trimble. 

About (О 
программе) 

отобразить номер версии программы, установленной на вашем 
компьютере. 
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Подключение к радиостанции 
Для подключения программы к радиостанции серии TDL: 
1. Запустите программу. 
2. С помощью поставляемого в комплекте кабеля подключите радиостанцию к 
последовательному порту компьютера. 
Если у вашего компьютера отсутствует последовательный порт, подключите 
кабель к переходнику (например, IOGEAR® GUC232A). 
Программа TDLCONF может подключиться только к радиостанциям семейства 
TDL. Для управления радиостанциями семейства PDL (Positioning Data Link) 
следует использовать программу PDLCONF, для радиостанций RFM - 
RFMCONF. Перечисленные выше программы доступны для бесплатной загрузки 
с сайта www.trimble.com. 
Радиостанция включится после подключения к источнику питания. 
3. Воспользуйтесь кнопкой Connect (Подключить), размещённой в правой части 
основного окна программы. 
Примечание: При подключении программы TDLCONF к радиостанции 
производится копирование текущих настроек радиостанции в память 
компьютера и перезапись текущих значений параметров. Если вы изменили 
содержимое набора параметров в программе, а после нажали Connect, то 
программа TDLCONF не будет запрашивать подтверждения сохранения 
изменений в файл. 
Отобразится следующее диалоговое окно: 

 
4. В диалоговом окне Connect to TDL Radio (Подключение к радиостанции TDL) 
выберите последовательный (COM) порт, к которому подключена радиостанция 
из списка Port (Порт), затем выберите скорость передачи из списка Data Rate 
(Скорость передачи). 
5. Для подключения к радиостанции TDL, подключенной к ПК через Интернет, 
выберите TCP и введите IP-адрес радиостанции 
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6. Для подключения к радиостанции TDL, встроенной в приемник Ashtech GNSS, 
выберите DSY и укажите число Pipe. 
7. Подтвердите перезапись текущих настроек выбором кнопки Yes (Да). 

 
8. Соединение устанавливается следующими способами: 
- Power On Capture ("При включении") Выключите радиостанцию. Выберите 
вариант Power On Capture и затем щелкните OK. В течение 10 секунд 
включите радиостанцию. 
Радиостанция примет пакет, переводящий его в режим приема команд от 
программы TDLCONF. 
- Soft Break ("Размыкание"). Этот способ используется по умолчанию. 
Убедитесь в том, что радиостанция была включена как минимум 4 секунды и 
затем щелкните ОК. 
Это вызовет передачу строки ASCII символов "+++", что и переведет 
радиостанцию в режим приема команд. 
Примечание: если радиостанция серии TDL ранее была подключена к 
внешнему устройству (например, компьютеру, GPS приемнику или 
измерительному устройству) с использованием другой скорости передачи 
данных, то программа не сможет установить соединение при отображаемой 
скорости, вследствие чего будет искать скорость, при которой соединение 
возможно установить. Некоторые версии операционной системы Windows и 
драйверы последовательных портов могут препятствовать такому режиму 
работы, в этом случае используйте следующий способ соединения: 
a) Выключите радиостанцию. 
b) Отключите её от компьютера. 
c) Подключите её обратно, но не включайте. 
d) Для соединения используйте способ Power on Capture (см. выше). 
Если ни один из этих способов не позволил установить соединение: 
1. Включите радиостанцию, после чего воспользуйтесь кнопкой Advanced 
(Расширенная настройка): 
2. Выберите Bootloader Power On Capture (Загрузчик при включении), затем 
щелкните OK: 



 

14 
 

 
3. В течение 10 секунд включите радиостанцию. Встроенное ПО загрузчика 
переведет прибор в режим приёма команд. 
 
 

Демонстрационный режим 

Для имитации подключения к TDL модему Вы можете запустить программу в 
демонстрационном режиме: 
1. Запустите программу. 
2. Нажмите [Alt]+[D] и затем щелкните ОК в диалоге Demo Mode 
(Демонстрационный режим). 
3. Воспользуйтесь кнопкой Connect (Подключение) в главном диалоговом окне 
программы, а затем проделайте шаги, описанные в разделе "Подключение к 
радиостанции" на странице 12. 
4. В описываемом режиме программа использует заранее заданную 
демонстрационную конфигурацию, так что вы сможете изучить особенности 
программы и порядок настройки параметров, аналогично подключению к 
реальной радиостанции. 
5. Вы можете загрузить заранее созданный файл конфигурации (*.dat), для этого 
выберите пункт меню File > Import (Файл > Импорт). В этом режиме 
допускается экспорт файла конфигурации. 
 
  



 

15 
 

Вкладка Identification (Идентификация) 
После подключения к радиостанции в TDLCONF отображается окно 
идентификации: 

 
Это диалоговое окно отображает текущую конфигурацию подключенной 
радиостанции: 

 Название модели 

 Номер версии встроенного ПО 

 Тип радиостанции - Transceiver (Приёмопередатчик) или Receiver 
(Приёмник) 

 Заводской номер (набор из 8-ми цифр, где первые две — год 
изготовления, следующие две — неделя изготовления, последние четыре 
увеличиваются, начиная с 0001) 

 Диапазон частот 
Эти поля изменению не подлежат. Также это диалоговое окно позволяет вам 
вводить позывной, имя владельца и идентификатор конфигурации. 
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Если вы работаете в США, то обратите внимание на то, что FCC (Федеральная 
комиссия по связи) требует, чтобы радиостанция каждые 15 минут передавала 
свой идентификатор. Идентификатор станции — это позывной, присвоенный в 
лицензии. Позывной передается азбукой Морзе. Он не включен в какой бы то ни 
было пакет данных и игнорируется при приёме. Тем не менее, во время посылки 
позывного передача данных прерывается на несколько секунд. Если Вы 
оставляете поле позывного пустым, то радиостанция, настроенная при помощи 
этого конфигурационного файла, позывной передавать не будет. Если вы 
работаете вне США, необходимость передачи позывного требуется уточнить в 
компетентных органах. Поле Configuration ID (Идентификатор конфигурации) — 
удобный способ задания номера конфигурации, загруженной в радиостанцию. 
Содержимое этого поля может и не совпадать с названием файла *.dat, 
сохраненного при использовании функции File > Export. 
При настройке радиостанции TDL 450H вы можете выбрать язык, который будет 
использоваться экранным интерфейсом. Для выбора доступны английский, 
китайский и русский языки. При использовании радиостанции TDL 450L доступен 
только английский язык. 
Для записи позывного, имени владельца и идентификатора конфигурации в 
радиостанцию воспользуйтесь кнопкой Program. Для сохранения изменений в 
файл конфигурации на вашем компьютере, выберите пункт меню File > Export. 
TDL радиомодемы записывают сообщения об ошибках в специально отведенное 
поле, если модем сталкивается с проблемой. Чтобы увидеть эти сообщения об 
ошибках, щелкните View Error Log (Показать Журнал Ошибок): 
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Вкладка Radio Link (Радиоканал) 
Доступные в этой вкладке параметры зависят от протокола, выбранного во 
вкладке Serial Interface (Последовательный интерфейс). Следующий пример 
показывает набор параметров, предлагаемых после выбора протокола 
Transparent EOT: 

 
 

Current Channel (Текущий канал) 

Таблица каналов состоит из строк со следующими параметрами в каждой: 

 Номер канала (от 1 до 32) 

 Номинал частоты приема 

 Номинал частоты передачи (может отличаться от частоты приема) 

 Ширина канала (одинакова для всех каналов, 25 кГц или 12,5 кГц) 
Также может присутствовать список серийных номеров радиостанций, которые 
могут использовать эту таблицу каналов 
Дилеры должны создавать таблицу каналов, основанную на лицензии 
пользователя и загружать ее в радиостанцию перед поставкой. Trimble просит 
пользователей, не получивших таблицу каналов вместе со своей радиостанцией 
серии TDL, связаться со своим дилером. 
Таблица каналов может содержать больше одного канала, но радиостанция в 
каждый момент времени использует один канал. Поле Current Channel (Текущий 
Канал) отображает номер выбранного в настоящий момент канала. Список под 
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этим полем отображает полную таблицу каналов. Для выбора другого канала 
щелкните по нему: 

 
Примечание: радиостанция не перейдет на другой канал до щелчка по кнопке 
Program. Все радиостанции серии TDL могут быть перепрограммированы с 
помощью программы TDLCONF, но некоторые модели позволяют 
пользователю производить выбор канала с помощью элементов 
пользовательского интерфейса. 
 

Import Channels (Импорт каналов) 

Для выбора другой таблицы каналов (она должна быть создана для вашего типа 
радиостанции авторизованным дилером Trimble) воспользуйтесь кнопкой Import 
Channels (Импорт каналов). Таблицы каналов являются файлами с 
расширением *.frq. Файлы с расширением *.upg — таблицы каналов, созданные 
с помощью программы PDLCONF для радиостанций серии PDL, и они не 
совместимы с радиостанциями TDL. 
Примечание: Законы большинства стран запрещают пользователям, не 
имеющим действующей лицензии, вещание на определенных радиочастотах. 
Пользовательская версия TDLCONF не поддерживает создание собственных 
таблиц каналов. При необходимости создания таблицы каналов, которая 
будет удовлетворять условиями действующей лицензии и не нарушать 
законов Вашей страны, Вам надо обратиться к своему дилеру. 
 

Scan Mode (Режим сканирования) 

Выберите параметр MANUAL, если вы хотите выбрать канал вручную. Выберите 
опцию AUTOROVER1, чтобы радиостанция автоматически сканировала всю 
таблицу каналов, и выберите один с самым сильным уровнем сигнала. Режим 
AUTOROVER 1 будет выполнять одно сканирование при включенной 
радиостанции, а затем сбросит радио в режим MANUAL. Режим AUTOROVER 2 
будет выполнять сканирование сильного сигнала при включенной радиостанции 
и выполнит последующую проверку, если число принятых пакетов данных 
упадёт ниже 90%.Выберите режим MANUAL, если вы хотите выбрать канал 
вручную. Выберите опцию AUTOROVER, чтобы радиостанция сканировала всю 
таблицу частот, и выберите один канал с самым сильным уровнем сигнала. 
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Link Rate (Канальная скорость передачи) 

В этом поле отображается скорость передачи/приема информации 
радиомодемом. Передача и приём происходят на одной скорости. По умолчанию 
скорость передачи для всех TDL радиостанций составляет 9600 бит/сек. Из 
выпадающего списка Вы можете выбрать другую скорость: 

 
 

Modulation Type (Тип модуляции) 

Это поле позволяет Вам выбрать способ модуляции сигнала: GMSK или 4FSK. 
По умолчанию у всех радиостанций серии TDL установлен метод GMSK, 
поскольку модулированный таким образом сигнал менее чувствителен к 
внешним помехам; тем не менее, модуляция 4FSK позволяет увеличить 
скорость передачи практически в два раза по сравнению с GMSK. Настоятельно 
рекомендуем вам использовать 4FSK, если вы установили скорость передачи 
больше, чем 9600 бит/сек. Чтобы сменить тип модуляции, выберите его в 
выпадающем списке: 

 
Не все протоколы поддерживают модуляцию 4FSK. Если во вкладке Serial 
Interface (Последовательный интерфейс) Вы выбрали тип протокола, 
несовместимый с выбранным типом модуляции, то при попытке 
запрограммировать радиостанцию с этими настройками появится окно 
предупреждения: 

 
Подробно сведения о возможных комбинациях настроек см. на стр. 38. 
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Sensitivity (Чувствительность) 

Для оптимизации работы при использовании разных типов сигналов при разной 
помеховой обстановке выберите уровень чувствительности из выпадающего 
списка (PDL радиостанции использовали термин Digisquelch): 

 
Общая рекомендация состоит в том, чтобы установить достаточно низкий 
уровень чувствительности, чтобы исключить влияние шумов, но при этом 
достаточно высокий, чтобы надёжно принимать полезный сигнал. Ниже 
приведённая таблица позволит вам выбрать необходимый уровень 
чувствительности, основываясь как на мощности сигнала, который Вы хотите 
принять, так и на уровне помех: 

  Сигнал 

  Сильный Слабый 

Помехи 
Сильные Low (низкая) Medium (средняя) 

Слабые Medium (средняя) High (высокая) 

 
Мощность сигнала уменьшается с увеличением расстояния от передатчика до 
приемника. Для увеличения эффективного расстояния вы можете повысить 
уровень чувствительности, хотя это может повысить уровень шума, 
воздействующего на приёмник. В некоторых случаях для определения уровня 
шума вам понадобится сканер или аналогичный прибор, определяющий 
мощность ВЧ сигнала. Если Вы не проводили измерения уровня шума в месте 
вашей работы, то можете руководствоваться следующей таблицей для выбора 
чувствительности: 

Для GPS cъёмки и аналогичных 
приложений 

Установите чувствительность 

Радиостанция базовой станции GPS  Low (низкая) 

Радиостанция приёмника-потребителя 
поправок  

High (высокая) 

Системы контроля окружающей среды  

Радиостанция датчика  Low (низкая) 

Радиостанция на базе  High (высокая) 

 
Уровень шумов может изменяться во время работы, поэтому Вам может 
понадобиться установить другой уровень чувствительности. Интерфейс 
большей части моделей TDL радиостанций позволяет изменять 
чувствительность без использования программы TDLCONF. 
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TX Power Level (Мощность передачи) 

При настройке радиостанции в качестве приёмопередатчика, Вы можете 
выбрать 
разные уровни мощности передачи. Выберите нужную мощность из 
выпадающего списка: 

 
Если радиостанция может использоваться только как приемник, это поле 
отмечено серым (т.е. выбрано быть не может). 
Поле Radio Type (Тип радиостанции) во вкладке Identification (Идентификация) 
показывает, является ли Ваша радиостанция приемником или 
приёмопередатчиком. 
Если вы настраиваете радиостанцию TDL 450H, то это поле позволяет задать 4 
уровня мощности в дополнение к уровню низкой мощности (2 Вт), который 
изменять нельзя; остальным уровням вы можете задать произвольную 
мощность, не превышающую максимальную мощность передачи, задаваемой во 
вкладке Dealer (Дилер). 
Выберите начальную мощность передачи, отметив ее галочкой. 

 
 

Address Settings (Настройка адреса) 

В полях Local (Собственный адрес) и Destination (Адрес назначения) Вы можете 
задать такие адреса двум TDL приёмопередатчикам Trimble, чтобы они 
связывались только друг с другом. 
Главное преимущество, которое дает вам задание адресов — это возможность 
разрешить прием передаваемой информации определенным приемником. 
Любой приемник, собственный адрес которого отличается от адреса назначения, 
указанного передатчиком, удалит принятый пакет и не будет транслировать его 
на другие радиостанции и перенаправлять на внешнее устройство (например, 
GPS приемник). Использование адресов позволяет многим парам передатчик- 
приемник работать на одном и том же канале без получения “чужой” 
информации. Использование адресов возможно только для пары радиостанций. 
Они должны быть предварительно настроены на протоколы Transparent EOT, 
Transparent EOC или Packet Switched во вкладке Serial Interface 
(Последовательный интерфейс). Собственный адрес одной радиостанции 
должен совпадать с адресом назначения другой, и наоборот. Например, 
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радиостанция с адресами Local=X и Destination=Y может установить соединение 
только с радиостанцией с адресами Local=Y и Destination=X. 
Примечание: не существует стандарта определения адреса. У каждого 
производителя они могут отличаться. Поэтому, при использовании 
радиостанций разных производителей в одной системе, адресацию 
использовать нельзя. Для того, чтобы задать собственный адрес и адрес 
назначения, щелкните на нужное поле (Local или Destination) и введите число от 
0 до 254. Каждой радиостанции можно присвоить только один собственный 
адрес и один адрес назначения. 

 
После выбора собственного адреса 255, радиостанция переходит в 
широковещательный режим. В этом случае все радиостанции Trimble, 
работающие на данном канале (независимо от их собственного адреса), могут 
принимать пакеты от данной радиостанции и либо транслировать их на другие 
радиостанции, либо отправлять их на внешнее устройство. Значения 
собственного адреса и адреса назначения, принимаемые по умолчанию - 0 и 255 
соответственно. Если вы не используете протоколы Transparent EOT, 
Transparent EOC или Packet Switched, то изменять эти значения не следует. 
Примечание: комбинация собственного адреса, равного 0, и адреса 
назначения, равного 255 - единственная, при которой будет работать 
радиостанция, настроенная только на прием. 
 

Transmit Settings (Параметры передачи) 

Если во вкладке Serial Interface (Последовательный интерфейс) вы выбрали 
один из следующих протоколов: TRIMTALK 450S , TRIMMARK II/IIe, TT450S 
(HW), 
или TRIMMARK 3, после чего отметили поле Repeater, Вам станут доступны 
следующие режимы ретрансляции: 
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 Выберите BASE with One Repeater для того, чтобы настроить 

подключенную радиостанцию как базовую станцию, передающую GPS 
поправки на один ретранслятор. 

 Выберите BASE with Two Repeaters для того, чтобы настроить 
подключенную радиостанцию как базовую станцию, передающую GPS 
поправки на два ретранслятора. 

 Выберите Repeater One для того, чтобы настроить подключенную 
радиостанцию как единичный ретранслятор или первый из двух. 

 Выберите Repeater Two для того, чтобы настроить подключенную 
радиостанцию как второй из двух ретрансляторов. 

 

Transmitter Retries and TX ACK Timeout (Число повторов передачи и 
Таймаут подтверждения передачи) 

Этот раздел вкладки Radio Link (Радиоканал) содержит три параметра 
радиопередатчика. 

 Transmitter Retries (Число повторов передачи) 

 TX ACK Timeout (Таймаут подтверждения передачи) 

 Repeater (Ретранслятор) 
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Примечание:Только протоколы Transparent EOT, Transparent EOC или Packet 
Switched поддерживают повтор передачи данных. Если вы выбрали любой 
другой протокол, то будет доступно только окно Repeater. 
 
Упомянутые протоколы требуют от радиостанци, принимающей 
дифференциальные поправки, передачи ACK (пакета подтверждения) на каждый 
пакет, принятый от радиостанции, передающей поправки. Радиостанция опорной 
станции повторяет передачу пакета (количество попыток определяется 
значением поля Transmit Retries) в случае, если она не получает ACK от 
радиостанции потребителя поправок в течение времени [мс], определяемого 
значением поля TX ACK Timeout. Этот алгоритм гарантирует 100%-ную передачу 
информации в периоды прерывистых помех. 
Если вы передаете информацию, для которой критичным является задержка при 
передаче (например, RTK поправки, обычно обновляемые ежесекундно), то не 
задавайте значение в поле Transmit Retries таким, что время ожидания повтора 
передачи превысит период обновления данных. Общее правило – количество 
повторов передачи не должно превышать 
скорость передачи [бит/сек] / размер пакета [бит] * период обновления [сек] 
Например, если вы передаете пакет с поправками размером 2400 бит каждую 
секунду на скорости 9600 бит/сек, число повторов передачи должно составлять 
менее 4, поскольку четырёхкратная передача пакета размером 2400 бит с RTK 
поправками на этой скорости будет продолжаться больше одной секунды, а 
каждую секунду у Вас появляется новая, более точная поправка. 
 
Поставьте галочку в поле Repeater, если вы хотите, чтобы ваша радиостанция 
работала в качестве ретранслятора (автоматически передавала получаемые 
пакеты). После выбора этого поля, появится поле Repeater Delay (Пауза 
ретрансляции). Введите в нем желаемую продолжительность интервала между 
приемом и передачей информации (в миллисекундах): 

 
 

CSMA (Множественный доступ с контролем несущей) 

TDL радиостанции производятся с включенным CSMA. В США запрещена 
передача без применения этого протокола. Когда множественный доступ с 
контролем несущей включен, радиостанция будет анализировать доступность 
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выбранной частоты передачи. Номинал частоты передачи отображается во 
вкладке Radio Link (Радиоканал) в поле Current Channel (Текущий канал). Если 
передача от других радиостанций не обнаружена, будет осуществляться 
передача данных, полученных по последовательному интерфейсу. Если на 
данной частоте обнаружена мешающая передача (канал занят), то повторная 
проверка занятости канала будет произведена через 3,3 миллисекунды. 
Проверки будут продолжаться до тех пор, пока частота не будет свободна для 
передачи. 
 

Use Forward Error Correction (Использование прямой коррекции ошибок) 

После выбора этой функции в передаваемые пакеты вводятся дополнительные 
контрольные биты, позволяющие приемникам распознавать и исправлять 
ошибки передачи. Хотя использование прямой коррекции ошибок и 
отрицательно сказывается на пропускной способности канала связи, но может 
значительно увеличить его радиус действия; Trimble настоятельно рекомендует 
Вам использовать эту функцию. Это поле будет недоступно (закрашено серым), 
при использовании протоколов Trimble — они не поддерживают прямую 
коррекцию ошибок. Выбор протокола производится во вкладке Serial Interface. 
 

Advanced Settings (Расширенные параметры) 

Кнопка Advanced даёт доступ к следующим параметрам: 

 
 



 

26 
 

Disable Tx (Запретить передачу) 

Поставьте галочку в этом окне, чтобы отключить передачу. Это может вам 
понадобиться при проведении испытаний, в ходе выполнения которых Вы 
должны быть уверены в том, что радиостанция не будет переходить в режим 
передачи. Не забудьте затем снять этот признак, поскольку радиостанция не 
будет передавать данные. 
 

Scramble Control (Контроль перестановки) 

При демодуляции цифровой передачи приемник должен быть синхронизирован 
с передатчиком. Это трудно осуществить в случаях, когда передатчик посылает 
длинные последовательности единиц или нулей. Но если каждый N-ый символ 
будет инвертирован: ноль превращен в единицу, а единица — в ноль, и 
приемник будет ожидать этой инверсии, то он сможет легче синхронизироваться 
с передатчиком. Именно в этом и состоит алгоритм контроля перестановки, и 
поэтому мы предлагаем использовать его во всех радиостанциях. 
Если вы выбрали протокол, отличный от протоколов Transparent EOT, 
Transparent EOC или Packet Switched, то контроль перестановки будет 
автоматически отключен, несмотря на то, что будет выставлен флажок. 
Обратите внимание на то, что если в вашей системе одновременно 
применяются радиостанции Trimble и других производителей, Вам может 
понадобиться отключить контроль перестановки. 
Примечание: протоколы Trimble требуют использования контроля 
перестановки. Выбрав протокол Trimble, вы не сможете отказаться от его 
использования. 
 

Automatic Turn off (Автоматическое выключение) 

Радиостанция автоматически выключается, когда напряжение питания 
снижается до задаваемого пользователем уровня (по умолчанию 9 Вольт).  
Вы также можете выбрать, при каком напряжении радиостанция, если она 
оснащена соответствующим интерфейсом, предупредит Вас о разряде батареи. 
Например, если радиостанция выключается при напряжении 9 Вольт, и Вы 
установили порог предупреждения 1 Вольт, радиостанция предупредит вас, 
когда напряжение достигнет 10 Вольт, а выключится при напряжении 9 Вольт. 
При настройке радиостанции TDL 450H автоматическое выключение всегда 
включено и отмечено серым. Из-за повышенной мощности передачи 
радиостанции TDL 450H, батарея может быть повреждена из-за переразряда. 
Для предотвращения этого радиостанция предупредит Вас о низком заряде при 
напряжении 11 Вольт и выключится, когда напряжение батареи упадет до 10 
Вольт. 
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RX LED definition (Значение светодиода RX) 

Если ваша радиостанция оснащена индикатором RX, вы можете выбрать один 
из следующих признаков, который будет отображаться этим светодиодом: 

 Получен сигнал (уровень принимаемого сигнала выше уровня, 
используемого шумоподавителем) - значение по умолчанию 

 Принят пакет данных 
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Вкладка Serial Interface (Последовательный 
интерфейс) 
Эта вкладка содержит следующие параметры: 

 
В этой вкладке вы можете настроить последовательный интерфейс между 
радиостанцией и внешними устройствами, такими как компьютер с запущенной 
программой TDLCONF, GPS приемник или датчик контроля окружающей среды. 
Параметры, принятые Вами для соединения радиостанции с компьютером, 
будут применены и для соединения радиостанции со всеми внешними 
устройствами (кроме того случая, когда ваша радиостанция оснащена 
интерфейсом пользователя, позволяющим настраивать радиостанцию без 
программы TDLCONF). Сначала узнайте, какие параметры последовательного 
подключения требуются для GPS приемника или внешнего оборудования, а 
затем установите эти значения во вкладке Serial Interface. 
Канал последовательного порта, состоит из драйвера операционной системы и 
физического порта, как правило, использующего разъём DB9. Если ваш 
компьютер, GPS приемник, или другое внешнее устройство не имеет 
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последовательного порта, вы можете использовать USB адаптер для его 
подключения. 
 

Port (Порт) 

Baud Rate (Скорость передачи) 

По умолчанию скорость передачи между компьютером и радиостанцией 
составляет 38400 бит/сек. Из выпадающего списка Baud Rate Вы также можете 
выбрать другие скорости (от 4800 до 115200 ): 

 
 

Protocol (Протокол) 

Protocol Type (Тип протокола) 

Вы должны выбрать протокол — набор правил, управляющих порядком обмена 
данными между внешним устройством и вашей радиостанцией. Все 
радиостанции, 
объединённые в систему связи, должны использовать один и тот же протокол. 
Выберите нужный вам протокол из выпадающего списка протоколов: 

 Transparent with EOT Timeout 

 Transparent with EOT Character 

 Transparent FST 

 Packet Switched 

 TRIMTALK™ 450S 

 TRIMTALK II/IIE 

 TT450S (HW) 

 TRIMMARK™ 3 

 SATEL 

Протокол Описание 

Transparent Существуют три типа этого протокола. При его использовании 
пакеты не имеют полей адреса и обрамления. Тем не менее, 
должно быть определёно окончание блока информации (End of 
Transmission (EOT)). 
Для этого предлагается два способа: 
- Путём обнаружения интервала времени, в течение которого 
приём очередного символа не произошёл (EOT Timeout) 
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- Путём обнаружения особого символа (EOT Character) Для 
систем, в которых используются только радиомодемы 
производства Trimble, протоколом по умолчанию является 
Transparent with EOT Timeout. При его выборе введите время (от 
10 до 2560 миллисекунд) ожидания конца передачи. По 
умолчанию оно составляет 50 миллисекунд. 
Если вы выбираете протокол Transparent with EOT Character, то 
выберите ASCII символ, который будет использоваться для 
обозначения конца передачи. По умолчанию это ASCII символ 
NUL. Для выбора другого символа выберите один из вариантов в 
выпадающем списке EOT Character: NUL, SOU, STX, ETX, EOT, 
ENQ, ACK, BEL, BS, HT, LF, VT, FF, CR, SO, SI, DLE, DC1, DC2, 
DC3, DC4, NAK, SYN, ETB, CAN, EM, SUB, ESC, FS, GS, RS, US, 
SP, символы QWERTY клавиатуры, и так далее. 
Transparent FST — это протокол Trimble, оптимизированный для 
больших расстояний, высокой скорости передачи и большого ее 
объема. Он поддерживает только 4FSK модуляцию. 
Примечание: Не все протоколы обмена поддерживают 
модуляцию 4FSK. В случае попытки запрограммировать 
радиостанцию, выбрав протокол, несовместимый с типом 
модуляции (последний выбирается во вкладке Radio Link), 
появится предупреждение. 

Packet 
Switched 

Этот протокол отличается тем, что он является «командным» 
режимом. Во всех остальных протоколах поступающая через 
последовательный порт информация делится на пакеты и 
автоматически передается. При использовании протокола Packet 
Switched внешнее устройство должно обеспечить создание 
пакетов, перемежение символов, исправление ошибок, 
производить служебные операции и посылать команды 
радиостанции для передачи и приема данных. Это может быть 
полезно в определенных приложениях, в которых настройки 
(такие как выбор канала) должны изменяться оперативно и 
внешнее управляющее устройство может быть 
запрограммировано для исполнения этих функций. 

Trimble TDL радиостанции поддерживают следующие протоколы 
беспроводного обмена данными, разработанные компанией 
Trimble: 
TRIMTALK 450S 
TRIMTALK II/IIE 
TT450S (HW) 
TRIMMARK 3 
С помощью программы TDLCONF выберите тот же протокол, что 
используется на радиостанциях компании Trimble, 
задействованных в Вашей сети. При использовании остальных 
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протоколов Trimble для TDL радиостанции следует выбрать 
вариант TRIMTALK 450S. 

SATEL Протокол SATEL используется радиостанциями производства 
SATEL. Изделия серии TDL с ними полностью совместимы лишь 
при использовании протокола SATEL. Если этот протокол не 
отображается в выпадающем списке протоколов, перейдите во 
вкладку Radio Link и убедитесь в том, что выбранный вами тип 
модуляции — 4FSK, т. к. протокол SATEL использует только ее. 

 

Data Security (Защита информации) 

Если выбран протокол Transparent EOT/EOC или Packet Switched, то возможно 
передавать зашифрованные данные. Для этого введите любую комбинацию из 
8-ми символов (букв латинского алфавита или цифр) в поле Data Code 
(Защитный код), выставьте флаг Enable (Разрешить) и подтвердите внесённые 
изменения. Декодировать передаваемые пакеты смогут только радиостанции 
семейств TDL и PDL производства Trimble и Pacific Crest, с тем же защитным 
кодом. Протокол Pacific Crest должен использоваться в обязательном порядке. 
Радиостанции серии PDL настраиваются с помощью программы PDLCONF 
(версия для дилеров), а радиостанции TDL с помощью TDLCONF (любая 
версия). Функция защиты информации одинакова для обоих семейств, и следует 
использовать один и тот же защитный код. 
Примечание: если вы разрешите использование функции защиты 
информации, то радиостанция не сможет установить связь с 
радиостанциями, не использующими тот же защитный код. Т.о. эту функцию 
следует разрешать (запрещать) для всех станций сети. В радиостанциях 
серии TDL, оснащённых кнопками и дисплеем предусмотрена возможность 
оперативного управления этой функцией, остальные же радиостанции 
Trimble должны быть подключены к компьютеру и настроены 
соответствующей программой. 
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Advanced Settings (Расширенные параметры) 

Кнопка Advanced даёт доступ к следующим параметрам: 

 
 

Soft Break Disabled (Отключение программного "Размыкания") 

Обычно программа TDLCONF подключается к радиостанции методом Soft Break 
("Размыкание"), описанным в главе Подключение к радиостанции. Выставив этот 
флажок, вы сможете переподключиться к радиостанции без применения 
"Размыкания". Обычно это делается под руководством технического 
специалиста для решения возникших проблем с подключением. 
 

Break to Command ("Размыкание" переводит в командный режим) 

Эта функция разрешает использования аппаратного размыкания линии для 
перехода в командный режим (из режима передачи данных), что может быть 
использовано в системах, предусматривающих изменение параметров 
радиостанции внешними устройствами, например, контроллерами сбора данных. 
Для отказа от обработки аппаратного размыкания снимите этот флажок. 
 

Turn off radio LCD backlight after 20 seconds (Отключение подсветки экрана 
после 20 секунд) 

Если этом флажок выставлен, и радиостанция оборудована ЖКИ дисплеем, 
через 20 секунд после последнего нажатия кнопки пользовательского 
интерфейса подсветка экрана будет отключена. Снимите флажок для того, 
чтобы подсветка оставалась включенной при включенной радиостанции. 
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Enable/Disable Radio Configuration via radio interface 
(Разрешение/Запрещение настройки радиостанции через интерфейс 
пользователя) 

Некоторые модели радиостанции снабжены элементами пользовательского 
интерфейса, позволяющими произвести изменение параметров без применения 
программы TDLCONF. Чтобы избежать случайной перенастройки радиостанции, 
снимите этот флажок и воспользуйтесь кнопкой OK, чтобы вернуться к главному 
экрану, и в нём воспользуйтесь кнопкой Program. Для включения этой функции 
выставьте флажок и запрограммируйте радиостанцию. 
Радиостанции с ЖКИ дисплеем воспроизводят экранную форму Edit Config, 
котором отображается признак разрешения настройки с помощью элементов 
пользовательского интерфейса. Текущее состояние отображается во второй 
строке экранной формы и помечено звездочкой. Для изменения этого параметра 
нажмите стрелку вниз для отображения другого варианта, после чего – клавишу 
Enter. После этого Вас попросят ввести пароль. Для всех TDL радиостанций он 
одинаков - 369369. Чтобы ввести этот код, нажмите стрелку вправо — во втором 
ряду появится цифра 3. Затем стрелки вниз и влево — появятся 6 и 9. Нажмите 
еще раз три эти кнопки в той же последовательности, и вы увидите на экране 
369369. После ввода этого пароля нажмите Enter и признак разрешения 
настройки радиостанции через интерфейс будет изменён. 
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Вкладка Frequencies (Частоты) 
Эта вкладка предоставляет доступ к следующим параметрам: 

 
В этой вкладке вы можете настроить радиостанцию только с каналами, 
работающими на прием. Когда вы в первый раз заходите в эту вкладку, текущая 
таблица каналов отображает частоту приема канала 01 в поле RX (Частота 
приема.  
Для того чтобы добавить еще один канал, щелкните по каналу, обозначенному 
как “unused” (неиспользованный), выберите поле RX и введите номинал частоты, 
на которой будет осуществляться приём на выбранном канале. 
Если Вы хотите обнулить настройки канала и выставить во всех его полях 
значение unused, выберите нужный канал, и затем щелкните по кнопке Clear 
(Очистить). 
Если Вы хотите обнулить настройки всех каналов и выставить во всех полях 
таблицы каналов значение unused, выберите нужный канал и затем щелкните по 
кнопке Clear All (Очистить всё). 
Для перемещения канала вверх и вниз в списке каналов выберите канал, затем 
либо щелкайте по стрелкам “вверх” и “вниз” справа от таблицы каналов, либо, 
удерживая кнопку мыши, перетащите канал на новую позицию. 
Таким образом Вы можете настроить отображаемые в программе TDLCONF 
таблицы каналов. Для того чтобы запрограммировать эту таблицу каналов в 
радиостанции, вы должны щелкнуть Program. После этого, выберите пункт меню 
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File > Export (Файл > Экспорт) для сохранения файла .dat в файловой системе 
компьютера. 
 

Импорт таблицы каналов 

Для отображения таблицы каналов, созданной заранее программой TDLCONF, 
щелкните на кнопке Import и выберите нужный файл с расширением *.frq. 
Примечание: Только дилер может запрограммировать радио таблицей 
каналов, содержащей частоты передачи, за исключением случая, когда 
заводской номер радиостанции был внесен в таблицу каналов. Пожалуйста, 
свяжитесь со своим дилером для того, чтобы он создал полную таблицу 
каналов, внеся туда заводские номера используемых Вами радиостанций. 
Радиомодемы Trimble используют задающий генератор на частоте 18 МГц. 
Гармоники этой частоты (396, 414, 432, 450 и 468 МГц в рабочем диапазоне) 
мешают приёму, поэтому их использовать не следует. 
 

Экспорт таблицы каналов 

После создания таблицы каналов на прием, щелкните по кнопке Export, после 
чего задайте каталог и имя файла для сохранения ее на компьютер. 
Примечание: только Ваш дилер может создавать или редактировать 
таблицу, позволяющую передачу информации. 
 

Коды регионов 

В зависимости от страны и региона могут потребоваться различные настройки 
радио. 
Настройте радиомодем TDL для соответствия правилам вашей страны или 
региона. Только авторизованные дилеры Trimble способны изменить код 
региона. Если выбранный код не подходит, пожалуйста, свяжитесь с Вашим 
дилером. 
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Программирование радиостанции 
При запуске программы TDLCONF она отображает пустой файл. Для 
подключения к радиостанции и открытия файла, содержащего её параметры, 
щёлкните по кнопке Connect. Если вы изменяете параметры, в заголовке окна 
отображается звездочка. Перед выходом из программы щелкните по кнопке 
Program для сохранения изменений, в противном случае они будут утеряны. 
Для сохранения в файле изменений, сделанных в программе TDLCONF, 
воспользуйтесь пунктом меню File > Export. 
После щелчка по кнопке Program производится запрос подтверждения 
изменения параметров радиостанции: 

 
После успешного изменения параметров появляется сообщение: 

 
После щелчка по кнопке OK программа позволит вам сохранить новые 
настройки в виде TXT файла. Для сохранения их в DAT файл, который вы 
сможете загружать на другие TDL радиостанции, выберите пункт меню File > 
Export. 
 

Конфигурации с большим тепловыделением 

Количество теплоты, выделяемое любым передатчиком, зависит от параметров 
его работы. Определённые наборы параметров работа в режиме передачи 
более продолжительна, и, соответственно, перегрев передатчика более 
вероятен. 
Поскольку этот фактор значительно влияет на 35 Вт радиостанцию TDL 450H 
(особенно по сравнению с 4 Вт TDL 450L), при попытке запрограммировать TDL 
450H набором параметров с большим тепловыделением, программа выдаст вам 
предупреждение с тремя вариантами дальнейших действий: Cancel (Закрыть), 
Continue (Продолжить) и ОК. 
Если вы нажмете на кнопку Cancel (Закрыть), будет произведён возврат без 
перепрограммирования радиостанции, что позволит вам выбрать конфигурацию 
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с меньшим тепловыделением. Для этого Вы можете, например, повысить 
скорость передачи или переключиться на более эффективный протокол 
(например, TRIMMARK 3 или Transparent FST). Оба действия уменьшают время, 
затрачиваемое на передачу, вследствие чего уменьшается и тепловыделение. 
Если вы нажмете на кнопку Continue (Продолжить), то радиостанция будет 
перепрограммирована текущей конфигурацией. Автоматическая система 
управления питанием TDL 450H будет поддерживать безопасную для работы 
радиостанции температуру. 
Если вы нажмете на кнопку ОК, то программа автоматически установит 
максимальную мощность передачи 25 Ватт. Изменить этот уровень мощности вы 
сможете только с помощью программы TDLCONF, пользовательский интерфейс 
радиостанции не позволит Вам это сделать. 
Есть и другие способы уменьшения температуры радиостанции TDL, помимо 
уменьшения мощности передачи. Использование формата CMRx уменьшит 
размеры пакетов на 60% и радиостанция, в свою очередь, будет выделять на 
60% 
меньше тепла. В жаркую погоду поднимите радиостанцию выше над землей и 
разместите её в тени – эти меры могут уменьшить её температуру на 20°С. 
 

Поддерживаемые комбинации параметров радиостанции 

Разные комбинации параметров - ширины канала, протокола, типа модуляции – 
позволяют поддерживать разные скорости передачи данных. Не всякая 
комбинация поддерживает все возможные скорости передачи. Поскольку 
встроенные дисплеи, доступные на отдельных типах радиостанций, отображают 
связанную последовательность экранных форм, после выбора значения 
очередного параметра происходит отображение только поддерживаемых 
значений параметров. При работе же с программой TDLCONF пользователи 
часто переключаются с одного окна на другое, подбирая нужную конфигурацию. 
По этой причине выбор конкретного значения параметра не ограничивает 
возможность выбора значений других параметров. 
Для устранения возможности задания Вами недопустимого набора настроек, в 
случае выбора неподдерживаемой комбинации и после нажатия кнопки Program 
отображается окно предупреждения. Появившееся сообщение об ошибке 
предложит вам обратиться к этой части Руководства пользователя. 
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В приведённых ниже таблицах перечислены поддерживаемые комбинации 
значений параметров. При использовании таблиц прежде всего определитесь с 
шириной используемого вами радиоканала. Текущее значение этого параметра 
отображается в поле Current Channel (Текущий канал) окна Radio Link 
(Радиоканал); предусмотрено использование каналов шириной 12,5 кГц или 25 
кГц). 
 

Ширина канала 12,5 кГц 

Тип протокола Тип модуляции Скорость 
передачи 
(бит/сек) 

Transparent EOT/EOC and 
Packet Switched 

GMSK 4800 

Transparent EOT/EOC and 
Packet Switched 

4FSK 9600 

Transparent FST 4FSK 9600 

TRIMMARK 450s GMSK 4800, 9600 

TRIMTALK II/IIE GMSK 4800 

TT450S (HW) GMSK 4800 

TRIMMARK 3 GMSK 9600 (США) 

SATEL 4FSK 9600 
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Ширина канала 25 кГц 

Тип протокола Тип модуляции Скорость 
передачи 
(бит/сек) 

Transparent EOT/EOC and 
Packet Switched 

GMSK 4800, 9600 

Transparent EOT/EOC and 
Packet Switched 

4FSK 19200 

Transparent FST 4FSK 19200 

TRIMMARK 450s GMSK 4800, 9600, 16000 

TRIMTALK II/IIE GMSK 4800 

TT450S (HW) GMSK 4800, 9600 

TRIMMARK 3 GMSK 19200 (США) 

SATEL 4FSK 19200 
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Возвращение фабричных настроек 

Разные радиостанции семейства TDL по умолчанию применяют разные 
значения параметров. Какие бы изменения конфигурации радиостанции Вы не 
проводили, в её энергонезависимой памяти сохраняются настройки по 
умолчанию. Чтобы их применить, вопользуйтесь кнопкой Restore Factory 
(Вернуть фабричные настройки) в основном окне программы TDLCONF, или 
выберите пункт меню Edit > Restore Factory Settings. 
Программа TDLCONF прежде всего должна подключиться (переподключиться) к 
радиостанции. Подробнее см. раздел Подключение к радиостанции на стр. 12. 
Если программа TDLCONF уже отображает конфигурацию радиостанции, 
появляется следующее предупреждение: 

 
Выберите Yes (Да) для того, чтобы скопировать настройки по умолчанию из 
радиостанции в программу для их просмотра и изменения. При этом никаких 
изменений в радиостанции внесено не будет до тех пор, пока Вы не используете 
кнопку Program. При возвращении фабричных настроек программа TDLCONF 
сохранит текущую таблицу каналов. 
 

Отмена изменений настроек радиостанции 

Для отмены всех изменений, сделанных во время текущего сеанса работы 
программы TDLCONF, воспользуйтесь кнопкой Undo Changes (Отменить 
изменения) в основном диалоговом окне программы TDLCONF или выберите 
пункт меню Edit > Undo All Changes. 
Это действие отменит все сделанные в текущем сеансе изменения параметров. 
Всем параметрам будут присвоены значения, которыми они обладали на момент 
запуска программы. 
Нажатие кнопки Undo Changes (Отменить изменения) само по себе не 
изменяет конфигурацию радиостанции или какой-либо из конфигурационных 
файлов на Вашем компьютере. Единственный способ изменить настройку 
радиостанции - произвести изменения в программе TDLCONF, после чего 
воспользоваться кнопкой Program. 
 

Печать настроек радиостанции 

Для создания файла, в котором описывается текущая конфигурация 
подключенной радиостанции, выберите пункт меню File > Save Report. Для 
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печати конфигурации без создания файла воспользуйтесь кнопкой Print 
(Печать) в диалоговом окне программы TDLCONF. 
В появившемся диалоговом окне Print (Печать) выберите принтер, который Вы 
хотите использовать для печати, и щёлкните по кнопке OK. 
Примечание: Конфигурация, отображаемая программой TDLCONF, может не 
совпадать с конфигурацией подключенной радиостанции. Программа 
отображает конфигурацию радиостанции в момент её подключения, однако 
после этого Вы можете импортировать файл настройки с Вашего 
компьютера командой File > Import. Кроме того, Вы можете использовать 
программу TDLCONF для изменения отдельных параметров. 
Импортированная или измененная конфигурация, отображаемая программой, 
не будет записана в радиостанцию до щелчка по кнопке Program. Если же вы 
нажмете Print до того, как нажмете Program – напечатана будет 
конфигурация радиостанции, а не та, что отображается программой 
TDLCONF. 
Звездочка в заголовке диалогового окна программы TDLCONF свидетельствует 
о том, что отображаемая конфигурация была изменена (отличается от 
конфигурации подключённой радиостанции): 

 
 

Закрытие программы TDLCONF 

Существует три способа выхода из программы TDLCONF: 

 Щелчок по кнопке Exit (Выход) 

 Щелчок по красному крестику в правом верхнем углу окна программы 

 Выбор пункта File > Exit 
Закрытие программы TDLCONF переводит радиостанцию в режим передачи 
данных. 
Если вы пытаетесь закрыть программу, сделав изменения в настройках, но не 
перенастроив радиостанцию с их помощью, появится окно предупреждения: 

 
 



 

42 
 

 Кнопка Export вызывает запись конфигурационного файла в выбираемый 
Вами каталог, после чего программа TDLCONF закроется. 

 Кнопка Program вызывает запись текущей конфигурации в радиостанцию, 
после чего программа TDLCONF закроется. 

 Кнопка Continue позволяет закрыть программу без сохранения изменений. 

 Кнопка Cancel позволяет вернуться к выполнению программы без 
дополнительных действий. 

Вы должны сохранить изменения перед закрытием программы – в противном 
случае они будут утеряны: 

 Вы можете сохранить изменения в файл на компьютере, нажав кнопку 
Export при закрытии программы, или же командой меню File > Export. 

 Вы можете сохранить изменения в подключённой радиостанции, нажав 
кнопку Program при закрытии программы, или же воспользовавшись 
кнопкой Program в основном окне программы. 

 


